Edgecam Getting Started Guide
## Contents

**Contents** ................................................................................................................. 2

**Introduction** ............................................................................................................. 4
  About this Guide ............................................................................................................ 4

**Other Resources** ..................................................................................................... 5
  What is Edgecam? ........................................................................................................... 6
  Supporting Applications ................................................................................................. 7

**Installing Edgecam** .................................................................................................. 8
  Installing Edgecam ....................................................................................................... 8
  If the Edgecam DVD does not Autorun ........................................................................ 8
  What else can I Install? ................................................................................................. 9
  Licensing your Edgecam Installation .......................................................................... 9

**Preparing Edgecam** ................................................................................................ 10
  Switching to Homework Mode ..................................................................................... 10
  Starting Edgecam ....................................................................................................... 11
  Registering Edgecam .................................................................................................. 11
  The Edgecam User Interface ...................................................................................... 12
The Milling Exercise

Loading the CAD Model ........................................................................................................ 14
Switching to Isometric View ................................................................................................. 15
Zooming In and Out ................................................................................................................ 15
Creating the Stock .................................................................................................................. 16
Using Undo ............................................................................................................................. 17
Showing Translucent Stock ................................................................................................... 17
Finding the Features ............................................................................................................... 18
Viewing Features in the Feature Browser ............................................................................... 20
Saving and Opening your Work ............................................................................................. 21
Specifying the ToolStore Database ...................................................................................... 22
Specifying the Material ......................................................................................................... 23
Creating the Machining Sequence ......................................................................................... 24
Drilling the Hole ..................................................................................................................... 25
Roughing the Part ................................................................................................................... 26
Rest Roughing the Part .......................................................................................................... 28
Machining the Flat Lands ....................................................................................................... 29
Profiling the Inner Profile (Central Boss) ............................................................................ 30
Profiling the Outer Profile ..................................................................................................... 32
Profiling the Pockets ............................................................................................................... 33
Simulating the Machining ...................................................................................................... 34
Generating CNC Code .......................................................................................................... 36
Exercise Summary .................................................................................................................. 37

Creating a Code Generator Exercise

Starting the Code Wizard ....................................................................................................... 38
Opening the Template ............................................................................................................ 38
Working through the Screens ............................................................................................... 40
Reviewing the Settings .......................................................................................................... 40
Saving the Configuration ....................................................................................................... 41
Compiling ............................................................................................................................... 41
Using the Code Generator ..................................................................................................... 41
Introduction

About this Guide

In this guide you work through a series of exercises that teach you some of the basics of using Edgecam and Edgecam Solid Machinist. You become familiar with the user interface and some of the Edgecam concepts.

The guide starts with overview information and a basic installation procedure. This is followed by some preparation of Edgecam for the exercises.

You then work through the complete process of producing toolpaths for machining a part supplied as a solid model.

Please note that:

- In the exercises you use the intelligence of Edgecam to quickly produce results. You see how Edgecam speeds up your work by automatically setting many of the machining details for you. As your knowledge of Edgecam increases you will learn how you can take more detailed control of your machining, if necessary.

- As a general introduction to the Edgecam software the guide is not a substitute for a formal instructor-led training course.

- The guide assumes that you are familiar with a PC and Microsoft Windows. Some experience with CAD/CAM methods and terminology would be beneficial, but is not essential.

- The guide is for use with Edgecam version 2016 R1 and above.
Other Resources

Other resources to help you in your Edgecam work are:

**Graphical help on your settings in dialogs**

**Online help accessible directly from dialogs**

---

**Edgecam Help menu**

- Some exercises that teach you important aspects of Edgecam design and manufacture.
- Details of new features in the release.
- Useful Web-based support resources
What is Edgecam?

Edgecam is a computer aided manufacturing (CAM) system that allows you to generate machining strategies and CNC code from CAD models.

Here are the main stages in using Edgecam:
Supporting Applications

To support the core Edgecam activities there are a number of tools and utilities. You can access these from the Edgecam program group (Start menu ► All Programs ► Edgecam):

**Code Wizard** - Configure the requirements of a CNC machine into a new code generator, which is then used to produce CNC code tailored to that machine. (Not available in Homework Mode.)

**Comms Setup** - Set up communication links so that you can transmit and receive files between PCs and machine tools over your local area network. (Not available in Homework Mode.)

**Editor** - A dedicated CNC file editor with essential editing, comparison and formatting features.

**Job Manager** - Manage 'jobs' (kits of tooling).

**Technology Assistant** - Automatically calculate feeds and speeds for tools to be used within Edgecam.

**Toolkit Assistant** - Manage your ToolStore database more effectively and streamline the process of preparing to write an NC file.

**ToolStore** - Store, manage and retrieve details of your tools.

**ToolStore Administrator** - Manage your tooling databases - switch active database, backup, restore, delete and so on.

**Utilities** - A range of utilities for managing the Edgecam environment. There is a utility for setting the paths for various categories of Edgecam related files for example, or for restoring factory settings.
Installing Edgecam

Installing Edgecam

On inserting the DVD the Edgecam Installation screen appears.

Click Install Edgecam and follow the on-screen instructions.

For a quick and easy installation that is ready for the exercises, at the prompts accept all the default choices. At the ‘Type of Installation’ prompt choose Typical.

If the Edgecam DVD does not Autorun

The installer should start automatically when you insert the Edgecam DVD.

If the installation menu is not displayed automatically:

1. Open Explorer and go to the Edgecam installation DVD.
2. Double-click starthere.hta to display the menu.
**What else can I install?**

You have already installed the necessary software for the exercises.

For your information, here are some other software options:

<table>
<thead>
<tr>
<th>Install</th>
<th>If</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edgecam CAD Links</td>
<td>You want to be able to launch Edgecam from your CAD system. You can install links in:</td>
</tr>
<tr>
<td></td>
<td>• Autodesk Inventor</td>
</tr>
<tr>
<td></td>
<td>• SolidWorks</td>
</tr>
<tr>
<td></td>
<td>• Solid Edge</td>
</tr>
<tr>
<td></td>
<td>Note that Part Modeler automatically includes a link to Edgecam.</td>
</tr>
<tr>
<td>Part Modeler</td>
<td>You want to use Part Modeler, a powerful solids-based CAD package.</td>
</tr>
</tbody>
</table>

**Licensing your Edgecam Installation**

To run Edgecam (industrial or educational version), you need to licence your software. There are two types of Edgecam licence, standalone or multiple user network licences.

For further information, please refer to the Licensing Guide. To access the Licensing Guide, click **Start** button ► **All Programs** ► **Edgecam 2016 R1** ► **Help** ► **Licensing Guide**.
Preparation Edgecam

Switching to Homework Mode

So that you can complete the exercises no matter what Edgecam licence you have, you use Edgecam in Homework Mode.

**Note:** If you are using an educational classroom or Homework license, you do not need to check the Homework Mode option.

To switch from licensed to Homework Mode

1. Exit Edgecam if it is open.
2. Find the Windows Notification Area (usually at the bottom right of the screen, where the time is displayed).
3. In this area right-click the CLS icon and on the shortcut menu click **Homework Mode** to enable it.

The next time Edgecam starts it will be in Homework Mode.

Switching back to Fully Licensed Mode

You might need to change back to fully licensed mode in between exercise sessions. To do this, close Edgecam (you can use the Close button in the top right corner of the Edgecam window - see page 21) and repeat the step above - clicking 'Homework Mode' again disables it, and Edgecam will next start in the normal licensed mode.
Starting Edgecam

In a standard installation:

- Click the Edgecam icon on your desktop.

- Alternatively on the Windows taskbar, click the Start button, then All Programs ► Edgecam 2016 R1 ► Edgecam Launcher 2016 R1.

- You see a message dialog stating you are in Homework Mode. Click Yes to continue.

Registering Edgecam

If you are starting Edgecam for the first time you now have an opportunity to register.

We strongly recommend you register your copy of Edgecam. This allows you to access online support and Frequently Asked Questions, track the progress of service calls and download the latest Edgecam updates.

After completing the registration Edgecam starts ready for you to begin work on a new part.
The Edgecam User Interface

Your Edgecam window should be configured for the exercises, and look like this:
The Milling Exercise

In the exercise you learn how to:

- Open a solid model.
- Change the view - select Isometric and zoom in and out.
- Create stock.
- Specify the stock material.
- Undo after a mistake.
- Find 'features' in the solid model, on which to base your machining.
- Save your work.
- Specify a ToolStore database.
- Create machining for the features using 'operations'. An operation is a complete package, including machining cycles (that control the toolpath) and any necessary moves to tool change, tool changes and so on.
- Simulate your machining.
- Generate CNC code for the machining.
Loading the CAD Model

1. On the Edgecam Launcher, click **New Milling Part**.
2. On the **File** menu, click **Open**.
3. In the Open dialog, navigate to the folder:

   `installation folder\Cam\Examples\Tutorial\Solid Machinist\Parasolid`

   For example:

   `C:\Program Files\Vero Software\Edgecam 2016 R1\Cam\Examples\Tutorial\Solid Machinist\Parasolid`

4. From this folder open **prismatic milling.x_t**.
5. On the Component Setup menu, click 🔄 to swap to the Mill environment.

The part opens looking like this:
Switching to Isometric View

You can change the view to 'Isometric' for a more three dimensional impression of your part:

- Right-click on the View Caption (in the bottom left corner of the graphics area) and on the shortcut menu click Isometric.

Your part now looks like this:

![Isometric View Image]

Zooming In and Out

You can enlarge or reduce the size of the part on the screen:

- Roll the top of the mouse wheel away from you to zoom in.
- Roll the top of the mouse wheel towards you to zoom out.
Creating the Stock

Stock represents the billet of material from which the part is to be machined. (When you come to use Edgecam Simulator this material is shown being machined away to produce the part.) To create the stock:

1. On the Setup menu, click **Fit Stock**.
2. In the dialog that opens, click **Box**.
3. Click **OK** to add the stock.

An outline appears showing your added stock.
Using Undo

If you make a mistake you can cancel your last action:

1. On the Quick Access toolbar, click Undo.

Your added stock disappears. You could now recreate stock with different settings, for example.

Our stock is OK however, so to 'undo the undo':

2. On the Quick Access toolbar, click Redo.

Your stock reappears.

Showing Translucent Stock

1. Click Render Stock in the top left of the Graphics area.

   The stock display changes to 'translucent'.

2. Click the button again to switch back (to 'wireframe').

   Leave the stock displayed as you prefer (stock is shown as wireframe in the exercises).
Finding the Features

Features are specific shapes of the model that you can identify in Edgecam and base your machining on. To find features:

1. The CPL Selector needs to be set to Top. If it is not, click on the selector and in the list that opens click Top.

2. On the Features menu, click Feature Finder.
3. In the Feature Finder dialog leave the General tab settings at their defaults. (Ensure that **Select Faces** is not checked. With no CPL set it will default to Top.) In the **Mill** tab, set the options as shown here. Then click **OK**.

4. Note how features are displayed in a 'tree' view in the Features window:
Viewing Features in the Feature Browser

The Features window is a central area for working with the loaded solids, and any features found in the solids.

By default, features are shown in a ‘Tree’ view.

For an alternative display, click the List View button in the title bar of the Features window.

In ‘List’ view, features are presented in a table, with one row per feature and columns for some of the feature properties. Features are grouped together by feature type.

To continue with the tutorial, switch back to the tree view. Note how the features are now also displayed in the new order in this view.
Saving and Opening your Work

It is a good idea to save your work regularly so you do not accidentally lose it:

1. On the File menu, click Save.

2. As this is the first save, a dialog opens for specifying a file name and location. Save to a folder and file name of your choice. For the file name you could add your initials to the default name (which is from the original solid model file).

All your work in Edgecam is saved to the '.epf' file, including features and machining instructions (which you will be creating in later exercises).

The '.epf' format is for educational purposes, with restrictions on what you can do with the file (for example you cannot generate CNC code). The normal licensed file format is '.ppf'.

You could now take a break from the exercise and close Edgecam:

1. Click the Close button in the top right corner of the Edgecam window. (Alternatively, on the File menu click Exit).

To reopen the file and continue with the exercises after restarting Edgecam:

2. On the File menu click Open, then navigate to the file and open it.
Specifying the ToolStore Database

You will be selecting pre-defined tools from ToolStore. Using ToolStore you can access tools from different databases, so you need to ensure you are using the correct example database that is installed with Edgecam.

1. On the **File** menu, click **Preferences**.

2. In the Preferences dialog, click the **Toolstore** tab.

3. The **Database** entry should be
   
   `computer_name\ecs\Sample_ToolStore<version number>`
   
   for example:
   
   `frank_smith\ecs\Sample_ToolStore_2015R1`

4. If this is not the entry, click **Modify** to open ToolStore Administrator.

5. In the Change Active ToolStore Database dialog, click **Browse...** to select a new active database. Select ‘Sample_ToolStore<version number>’ from the list and click **Select**.

6. Click **Change** to accept the changes and then **X** to close the dialog.

7. Click **OK** to close the Preferences dialog. The database switch is now complete.
Specifying the Material

As you will be using operations, speeds and feeds are automatically calculated. These are based on the material being machined, so you need to specify this.

1. On the Component Setup menu, select **Mild Steel EN8** from the Material drop-down list.
Creating the Machining Sequence

You now start to create your machining instructions.

1. On the Setup menu, click Create Sequence.

2. On the Create Milling Sequence dialog, Click to select Show All Machines.

3. Select training mill mm.mcp from the Machines list.

4. Click Next to display the New Setup dialog.

5. Click Next to display the New Sequence dialog and then click OK to confirm and close the dialog.
Drilling the Hole

Now you drill the hole through the centre of the part.

1. Select the Machining menu and click Advanced to display the Advanced features.


3. You are prompted to Select Points. Move the cursor over the centre of the hole in the boss until the hole changes colour. Now click, and the hole changes colour again to show it is selected.

4. Right-click to terminate the points selection or click the Finish button.

5. In the Hole Operation dialog, make these settings (see image on the right)

6. Click OK.

7. The Hole operation is now created. Click the Sequence window tab, then click the ‘+’ symbol for the Hole operation to see the instructions within the operation. (In the graphics area you see a graphic representing the automatically-selected tool. Note how this has been given the diameter of the hole.)
Roughing the Part

Now you rough the part.

1. On the **Mill Operations** toolbar, click **Rough Mill**.

2. You are prompted to **Select geometry to machine**.

   In the Features window, click **prismatic milling** and click the **Finish** button.

3. You are prompted to **Select boundary entities**... Terminate without selecting anything.

4. The Roughing Operation dialog opens.

   In the **General** tab make these settings. (Note how you see an explanatory graphic when you click an option.)

   Ensure that **Select Stock** is checked.

   Do **not** click OK yet.
5. Go to the **Tooling** tab and click **Find** to open ToolStore. In the tooling list scroll to **14.0 mm Multi-Flute End Mill** and click to select it. Click **Select**. (If at any point during the exercise you cannot see the required tool in the list, click **Use Filters** on the right side of the ToolStore dialog.)

6. Click the **Depth** tab and set **Clearance** to 5, **Level** to 0, **Depth** to 0 and **Cut Increment** to 2. Click **OK** to close the dialog.

7. You are prompted to **Select stock**. Rest the cursor on one of the lines comprising the top profile of the stock. The line changes colour and the ToolTip indicates 'Stock'. Double-click to select the whole top profile. Then right-click to terminate the stock selection.

The Roughing operation is now created. The toolpath is displayed on the part.

8. Click the **Sequence** window tab. Now click the '+' symbol for the Roughing operation to see the instructions within the operation.
Rest Roughing the Part

In the previous roughing operation the tool was too large to remove all the material (the tool could not fit into the pockets, for example). You now 'rest rough' with a smaller tool to remove this material.

To do this, repeat the previous Roughing operation, but with slight changes. Here is a summary, with the changes marked '*':

2. Select the whole solid.
3. Select no boundaries.
4. In the Roughing dialog, General tab, set Rest Rough to checked *, Offset to 0.2, and Select Stock to unchecked * (you can leave the other settings as they are).
5. Click the Tooling tab and from ToolStore select the tool 6.0 mm Multi-Flute End Mill-LS* (you can leave the other settings as they are).
6. Click the Depth tab and set Clearance to 5, Level to 0, Depth to 0 and Cut Increment to 2. Click OK to close the dialog and generate the operation. (There will be no prompt for stock.)
7. In the Sequence window rest the cursor on 3 Roughing Operation (that you have just created). Notice how the toolpath for the operation becomes highlighted.
Machining the Flat Lands

You now use a finishing tool on the flat areas, removing the material left by the 0.2 offset in the previous Roughing operations.

1. On the Mill Operations toolbar, click More... and select Flat Land Finishing from the list.

2. You are prompted to Select geometry to machine. Select the whole solid and terminate, as you did before for the Roughing operations.

3. At the Select boundary entities... prompt right-click to terminate without making a selection.

4. The Flatland Operation dialog now opens. In the General tab make these settings. (The Stand Off Distance leaves an un-machined border round the flats to be removed in subsequent Profiling operations.)

5. Click on the Tooling tab and from ToolStore select 8.0 mm Multi-Flute End Mill-LS. (Other settings can be left as they are.)

6. Click the Depth tab and set Clearance to 5, Level to -0.1 and Depth to 0.

7. Click OK to close the dialog and generate the operation.
Profiling the Inner Profile (Central Boss)

Now you profile finish the central boss, this time using a different method.

1. Click the Features window tab and in the Features window click on the lower 2D Boss.

   With a right mouse click, open the shortcut menu and select the Profiling Operation.

2. At the Select boundary entities... prompt right-click to terminate without making a selection.

3. The Profiling dialog now opens. In the General tab make these settings.

   Do not click OK yet.
4. Click the Tooling tab and from ToolStore select the 8.0 mm Multi-Flute End Mill (other settings can be left as they are). Remember, if you cannot see the tool in the list, click Use Filters on the right side of the ToolStore dialog.

5. Click the Depth tab and set Clearance to 5, Level to 0, Depth to 0, Cut Increment to 2 and Cusp Height to 0.

6. Click OK to close the dialog and generate the toolpath.

7. The tool graphic can sometimes get in the way. Use the View and Render buttons to remove the tool and holder. Repeat to show the tool again. Set this as you prefer.

With the tool now hidden you have an unobstructed view of the part and its new toolpath.
**Profiling the Outer Profile**

Now you machine the outer perimeter of the part.

To do this repeat the previous Profiling operation, but with slight changes. Here is a summary, with the changes marked '*':

1. Click the **Features** window tab and in the Features window click on the top **2D Boss***. As the feature is highlighted in the graphics area you may notice slot markers in the four recess areas. These are not used in this exercise.

2. With a right mouse click, open the shortcut menu and select the **Profiling Operation**.

3. Select no boundaries.

4. In the Profiling dialog **General** tab, set **Offset** to 0 and **Lead Radius** to 4. (Other settings can be left as they are).

5. In the Profiling dialog **Tooling** tab, check the **Use Current Tool** option. (Other settings can be left as they are.)

6. In the Profiling dialog **Depth** tab, set **Clearance** to 5, **Level** to 0, **Depth** to 0, **Cut Increment** to 2, and **Cusp Height** to 0. Click **OK** to close the dialog and generate the operation.

7. Rest the cursor on the new operation to highlight its toolpath.
Profiling the Pockets

You now machine the pockets.

To do this repeat the previous Profiling operations, but with slight changes. Here is a summary, with the changes marked ‘*’:

1. On the Mill Operations toolbar, click Profile Mill.

2. Select all four pocket features*. This time use a different method: Click the Features window tab and in the Features window click on the top 2D Pocket, then hold down the Shift key and click on the bottom 2D Pocket. Move the cursor back into the Graphics area and right-click to terminate the selection.

3. Select no boundaries.

4. In the Profiling dialog General tab, set Offset to 0 and Lead Radius to 4. (Other settings can be left as they are).

5. In the Tooling tab, click Find to open ToolStore. Select the 3.0 mm Multi-Flute End Mill*. (Other settings can be left as they are.)

6. In the Depth tab, set Clearance to 5, Level to 0, Depth to 0, Cut Increment to 2, and Cusp Height to 0. Click OK to close the dialog and generate the operation.

7. Rest the cursor on the new operation to highlight its toolpath.
Simulating the Machining

You can now simulate your machining. The simulation gives you a visual 'confidence check' of your machining. You can check, for example, that you have not forgotten to machine a feature, and that there are no collisions.

You will be quickly running through the main features of the Simulator, there are many more you will use with experience.

- In Edgecam, on the Machining menu click Simulate.

You see the Simulator window containing your un-machined stock:

Use these buttons on the Main toolbar to control the simulation at any time:

- Start/Resume
- Play # Cuts
- Stop
- Rewind (To Start)
- Fast Forward (To End)
Drag the Speed Control slider to the left and right to control the speed of the simulation.

If speed control is not enabled, click the Speed Control button to activate the slider.

**To simulate your machining sequence**

On the Main toolbar, click **Start** to begin the simulation.

You see your part being machined out of the stock. Notice how the progress of the simulation is indicated in the Sequence Browser.

Collisions are indicated by red ‘flashes’. To prevent collisions, you would edit the operation parameters and/or select a different tool, for example.
Generating CNC Code

Once machining is completed, you generate the CNC code.

- Back in Edgecam, on the **NC Code** menu click **Generate NC**.

A message tells you 'This option is not available in Homework Mode', so this is as far as you can go with the live exercise.

If you were working on a '.ppf' part in Licensed mode, you would see the Generate CNC Code dialog.

After specifying the CNC Name and clicking OK, the code would be generated. With the Open Editor option checked, the Editor program is opened, showing the just generated code.
Exercise Summary

You have now completed the exercise.

You have taken a solid model design and produced CNC code for producing parts to the design.

You have learnt how to:

- Open solid model parts generated in CAD packages.
- Change view - select Isometric and zoom.
- Create stock representing the raw billet.
- Specify the stock material.
- Find 'Features' in the model: holes, pockets and bosses.
- Save your work.
- Specify a ToolStore database.
- Create machining for the features, using operations.
- Use Simulator to provide a visual confidence check of your machining.
- Generate the CNC code.
Creating a Code Generator Exercise

A code generator interprets your Edgecam machining sequence to produce CNC code that is tailored to a particular target CNC machine. When you create a code generator you configure the characteristics of the target machine into it.

Code generators are stored files; a typical example is the 'facnuc3x.mcp' you used earlier. (There are also '.tcp' turning code generators and '.wcp' wire erosion code generators.) You create and configure code generators using the Code Wizard.

Starting the Code Wizard

You cannot run Code Wizard in Homework Mode, so you now need to switch to the normal licensed mode - see page 10 for details.

Then, in a standard installation:

- Click the Start button, then All Programs ► Edgecam ► Programs ► Code Wizard.

Opening the Template

A template contains a typical CNC machine configuration that you can use as a starting point, to be modified for your particular machine. You choose the template closest to your particular machine.

- After starting the Code Wizard you see this dialog. Click Start a new document and click OK.
In the next dialog click **Lathe** or **Mill**, depending on your type of work. (For this exercise, your choice is not important.)

- In the next dialog make further settings relating to your machine’s configuration.

Click on one of the ‘adaptive’ templates and click **OK**. (Again your choices are not important for the exercise.)
Working through the Screens

- You now see this wizard screen. Start to work through the screens to gain some idea of the settings you can make. Use the **Next** and **Back** buttons to navigate. You can simply step through the screens without making changes. This screen keeps reappearing to show the completed steps. You can click on a step (such as ‘3: NC Style....’) to jump straight to it ‘out of sequence’. At any time you can click **Finish** to accept the defaults.

Reviewing the Settings

- Once you have completed the wizard you can still make changes. You now work in a ‘tree’ view of the settings. Click the ‘+’ symbol to open a branch. Double-click on an entry in the tree to open a dialog for changing the settings.
Saving the Configuration

You can save your settings. Once saved you can restore and change them later, in the tree view, without having to work through the wizard again.

1. On the Standard toolbar (or on the File menu), click Save.
2. Use the dialog to save the '.cgd' file with a name, and in a folder, of your choice.

Compiling

- On the Standard toolbar (or on the File menu), click Compile.

  A code generator file is created. This is automatically named after the saved '.cgd' file (or 'Untitled' if there was no save), with the appropriate extension (such as '.mcp' for a milling code generator).

Using the Code Generator

You use the code generator by specifying it as the Machine Tool setting in the Machining Sequence dialog.

You did this in the milling exercise; see page 24.
Index

B
Boundary entities - selecting ...................................... 26

C
CAD part - loading................................................... 14
Cancelling last action................................................ 17
Central boss - profiling ............................................. 31
Clearance - setting.................................................... 25
CNC code
  editor ................................................................. 37
  generating.......................................................... 37
Code generator
  compiling ............................................................ 43
  creating............................................................. 39
Code Wizard
  opening template .................................................. 39
  saving configurations ........................................... 43
  stepping through ................................................ 42

E
Edgecam
  DVD ................................................................. 8
  installing .......................................................... 8
  registering ........................................................ 11
  starting ............................................................. 11

F
Feature browser .................................................... 20
Feature finding ...................................................... 18
Flatland operation .................................................. 30

H
Hole - drilling ....................................................... 25
Hole operation - creating ......................................... 25
Homework mode - switching to .................................. 10

I
Inner profile - machining .......................................... 31
Installing Edgecam .................................................. 8
Isometric view - selecting ........................................ 15

L
Licenced mode - switching to .................................... 10
Loading, CAD model ............................................... 14
Lower boss - profiling ............................................. 33

M
Machining - simulating ............................................ 35
Machining sequence - creating ................................... 24
Material - specifying .............................................. 23
Milling exercise - introduction .................................. 13

O
Opening parts ....................................................... 21
Outer profile ......................................................... 33
P
Part Modeler installation...............................................8
Parts - saving..............................................................21
Pockets - profiling..........................................................34
Pockets - roughing ..........................................................34
Profiling operation - creating ...........................................33

R
Registering Edgecam .....................................................11
Rest roughing ...............................................................29
Roughing operation - creating ...........................................26

S
Saving parts.................................................................21
Security Key - fitting .......................................................9
Sequence................................................................. See machining sequence
Setup - running ...........................................................8
Simulating - speed control...............................................36
Simulating machining .....................................................35
Solid model - loading .....................................................14
Specifying material .......................................................23
Starting Edgecam ........................................................11

Stock
creating ........................................................................16
showing translucent .......................................................17
Student Edition mode - switching to .........................10
Switching views ...........................................................15

T
Template - opening .....................................................39
Template, Code Wizard ................................................39
Tool diameter - specifying .............................................28
Tool graphic - hiding .....................................................32
ToolStore
selecting tools in .......................................................28
Translucent stock .........................................................17

U
Undo .................................................................17
Undo command ...........................................................17
Upper boss - roughing ..................................................26
User interface
overview .................................................................12

V
Viewing Features .......................................................20

Z
Zooming .................................................................15